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Getting started with iRacing telemetry

Saving telemetry to disk

iRacing now has the ability to save vehicle telemetry to disk any time you are driving in a session.
To arm the telemetry system press 'alt-L' on your keyboard at any time, you do not need to be in
your car.

Once armed, an icon will appear on your display indicating that the telemetry system is activated.

When you enter your car, the icon will light up to indicate that telemetry is being saved out to disk.

Telemetry

N

0 mph

Every time you enter your car, a new telemetry file will be saved to your [My
Documents] \iRacing\telemetry)\ folder.

ATLAS
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Setting up McLaren ATLAS

You can use McLaren ATLAS to view the log files after your session is complete.

AATLAS Express - iRacing Example MX5.wbk (== EoE ==

File Session View Tools Window Help

E@S & 2 IS R P B B [ 2 [N 0O [ e » » » T[F@
L L L <l 1
EREEN o] ]

L1 mi5 cup_oks

A
P \,‘*

N7 f-‘
V[

My Speeds - mxS cup_okaya

Driver | Input Views  Chassis |Engine | Gears | FFT
Function F_SteeringWheelPctTorque compiled successfully. Li:offline

First you will need to download and install ATLAS from the resources pane on the iRacing member site.
You can reach it from this url: http://membersmedia.iracing.com/atlas/ATLAS.msi

You will also need to download the iRacing ATLAS session data from the resource pane as well.
You can access it from the following url:
http://membersmedia.iracing.com/atlas/iRacing_ ATLAS plugin.zip

Unpack the iRacing ATLAS importer and copy the iracingSession.dl11 int0 [Program Files
(x86) ] \McLaren Electronic Systems\ATLAS 9\SessionDLLs\.

You may also want to use the included sample workbook and function list. Copy the contents of the
ATLAS 9\ directory into your [My Documents]\McLaren Electronic Systems\ATLAS 9\ SUb
directory.

— T ATLAS
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http://membersmedia.iracing.com/atlas/ATLAS.msi
http://membersmedia.iracing.com/atlas/iRacing_ATLAS_plugin.zip

Configuring ATLAS
The first time you launch ATLAS, you will need to make some small configuration changes.

First open the options dialog from the 'Tools->0ptions' menu. Select the 'standard’' tab and
change the default data path to point to your [My Documents]\iRacing\telemetry\ folder.

Then close the dialog with the OK button.

This folder may not exist until you have created your first telemetry file.

Options (-8 |mesa)
| Status Bar I MATLAE Sessions WinTax Session Formats I Text Session Formats
Standard | Functions Recording System Monitor folders I Advanced Decode DLLs

["}'Load sessions with workbooks!

[T Open last workbook when starting ATLAS
Use most recently used session list

Default data path:
"—-___C:"-.Llsers"-david.tuc:ker"-.Dou:uments"-.iRacing"atelemeD

Default workbool tolder:

C:WUsers'david tucker\Documents  McLaren Electronic Systems\ATLAS $\Workbooks
Local folder:

CiUsers\DAVID™1 . TUC AppData® Local' Temp®.

Circuits folder:

C:MUsers'david tucker' Documents' McLaren Blectronic Systems"ATLAS S'Circuits
Bitmaps folder:

C:hUsers'david tucker\Documents  McLaren Electronic Systems \ATLAS $\Bitmaps
Layer description detail text

O O O 65O O

Custom Displays folder :

C:\Program Files (<86)\McLaren Blectronic Systems " ATLAS $\CustomDisplays [3

ATLAS ini file location:

C:MUsers'david tucker' Documents' McLaren Blectronic Systems ATLAS 9\Atlas ini [3
OK || Cancel |[ foply |[ Hep |

ATLAS
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Loading a workbook

Let's start off by loading up the default 'iRacing Example Mx5.wbk' file by selecting 'File->0pen’
from the menu. This will bring up a series of charts, and configure the track definitions for you. Later
we will cover the steps needed to create a workbook from scratch.

ATLAS Express - Workbook2
File Session View Tools Window Help

(BB s e NEEE e SENS N BN

Open

o~
) ' <« My Documents » McLaren Electronic Systems » ATLASS » Workbooks v‘&,“ Search Workbooks 2|

Organize v New folder 4= v ﬂ ‘9‘
iRacingAlpha s Name ‘ Date modified Type Size

iRacingBeta e T - - ——
B iRacing Example MX5.wbk 5/16/2011 3:56 PM ATLAS Workbook 1,036 KB

iRacingMembers — - —— — gy
@ iRacing FFB.wbk 5/16/2011 3:55 PM ATLAS Workbook 157 KB

iRacingSecure
McLaren Electronic System|=
ATLASS

Bitmaps
Checks
Circuits
Config
Data
Exportlobs
Funclib
Log
Workbooks

-~ < T »

File name:  iRacing Example MX5.wbk [ Workbook Files (*wbk) -]

I Open 17] ‘ Cancel !

Once your workbook is loaded, you need to load up some data to view.

To do this select the menu option 'session->Load’'.

You will need to select the 'iRacing binary telemetry' file format from the drop-down on the left
and then pick one of the . ibt telemetry files that you have previously generated from the iRacing
simulator and click open.

For now let's load the 'mx5 cup okayama full 2011-05-13 10-29-42.ibt sample telemetry file.

ATLAS
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I ATLAS Express - iRacing Example MX5.whblc
File Session

View Tools Window Help

FLEIC R A D B |

My Driver Inputs - Layer 1

3 Load Session

4 I

7] Load function constants ¥|Load assodate sessions

Your workbook should now look something like this.

£ 4 F All Sessions - YT @ [100
Sessionpath:  D:ADTucker_W5hdepothfirstidoeshatias quickstartuedistim5 cup_ckayama full 2011.05-13 10-28-42.ibt -
2 Name Type Versi... Ses
datab
* otebase ATLAS 9
£ ). docs
@ alpha = ]
= atlas quickstar| £ = Laps
- ) redist i Outlap
i | award_templa 5 Lap2
cameraDoc 5 Lap3
% | datacenter > Lapd
designs o Lap5t
# ') NASCAR HOF :
i Lap6
releases
- | renderer o lept
schedule 5 Inlap
4 i » q i »
Name Type Versi.. Session Name Session Descriy
&% Layer1 (Active)
L3 Layer2

[ Load [

Cancel

ATLAS Express - iRacing Example MX5.wbk
File Session View Tools Windew Help

=3- N=l 4 [l R TR -t N ] i b

PR B |

EiE G

L1: M5 cup_ L o <l

Driver | Input views Chassis |Engine | Gears | [ a FFT

Function F_SteeringWheelPctTorque compiled successfully.

L:offline

Atlas comes with an extensive online help system. We recommend spending some time with it in order

to better understand this sophisticated application.
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Customizing your workbook

To get started plotting data let’s put up a simple waveform (graph). Click 'File->New' and select

Waveform from the list of options.

This will bring up a blank chart. In order to be useful we need to add in some variables for this

Mew
@ Display
) Pags

) work baok,

Standard :

=35

Lo ]I

Cancel ]

waveform to log. Select your blank waveform and click 'view->Properties'. This will bring up the

Properties dialog.

Properties - [Shocks] \E\
Parameters | Events I Layers I Diisplay I Woﬂ{bookl
Pvailable Selected:

Groups | Paramet... Description i LFshockDefl
iRacing O=brake released ... THFS:DCE g;
Sessi?n Details Car Car = Hﬂssh?:z:kDeﬂ
:dLIIr(IEC:;IE;Z Chassis_... Chassis number

Circuit Circuit

Clutch O=disengagedto 1...

Date_of .. Date of recording

Driver Driver

ECU_Se... ECU Seral Mo.

ECU_Ve... ECU Version

Engine_... Engine Description

Engine... Bitfield for waming 1.

Bdra_no... Bdra notes

F_Steer... Compute FFBE force. .

Fuellevel Liters of fuel remain...

Fuellev... Percent fuel remain...

FuelPress  Engine fuel pressure

Gear -l=reverse O=neutr...

la0nTrack  1=Car on track ok i

Filter:
[ ok || cancel | . Help

FRacing.com

ATLAS
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Variables in the iRacing group come straight from the telemetry data we loaded earlier. Variables in the
Functions group have been processed through a user defined function. Simply select a variable in the
parameters list and hit the add button. You may also select one or more variables and click on the
properties button to modify the displayed resolution and min/max scaling of the parameter.

Lecal Parameter Properties - [LFshockDefl] @
Appearance | Value
Name: | [MEEllsn| Units: m ..
Precision
Show Name ,_/ﬂc'rm:
Forma Colour: .
B Min/Max Range
) g Critical: Min
Max
0.08% [C1aver =
Mean
0.021 [ Under Start
Distribution End
Top: 100 %  Bottom: 1] % Change
T Previous lap
race
[ Hide trace [T]Y Scale: End Straight
[l Trace Wickh: by
Current
[ Show waming limits Line Style: o
Reset
Global [ ok [ Cancel || & Help

In addition to adding parameters to your waveform, the properties dialog can also be used to format the
charts display. Select the display tab to add in a track circuit map, or change the line styles, among

other things.

Properties - [Shocks]

Parameters I Everts I Layers | Display | Workbook

L7 sl

MName: EREE

General Format
[ Mways on top ] Do nat scroll across laps
[ On all pages [ Align arid to Y scales
Show title bar [ Show circuit stripe
[ Show note area Show circuit segments
Show private timeline Flash trace
Historic Draw shie: | Line -
Live
o
X Fods
© Tims [ Draw left to ight  Gap %: 0
() Distance Show legend
From Layer Param Justification ~ Right -
[T Time Into Lap [ Show cincuit
[ Multi-Column

Min precision: 3

[ Show waming indicator
Automatic resize

Calculate time diff from
(@ Start of lap

Start of segment
Start of section

Cursar

Show statistics

[ 7
Show columns:

[ Deta ] Min
[CIMean  [C] Max

[ Standard Deviation
Context menu enabled

Ref cursor uses:

[ Lap statistics -

[ ok || Ccance

ATLAS
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Advanced Topics

If you are creating a new workbook, you will want to go into the workbook tab and point ATLAS at

some of the parameters in your data.

Properties - [Shocks]

| Parameters | Events | Layers | Display | Workbook

Mamed Parameters

7] Auto Load Circut Map

MName: [Racing Example MX5 wbk

Distance: LapDist E] Gear:

Throttle: Throttle  [..) RPM:

Lateral G: LathccelG [ End Of Straight

Speed: Speed_KPH E] Wind Direction:

Comelation (Dist) Wind Speed:
Circuit

Circuit Definition File: C:\Usersh\david t... okayama full ckt B Timebase Events .

% Auto fit limit: 5 =

Advanced...

OK || Cancel || foph Help

It is especially important that you set up the Distance and Speed parameters. These together let ATLAS
display your data in distance mode instead of time mode. Distance mode plots all data against the
distance around the race track. This is very useful when comparing data from one run to the next.

Toggle Distance
mode on/off

At the bottom of the Load Session dialog notice that there are two layers available. You can load up
two session files at the same time for quick comparison and analysis. Simply double click on the layer
you want to load the session file into, then select the session file you want to load and hit the load

button.

" haipacem N —AAD
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3 Load Session

= [[o] 5]

@ & T [NISessions

Search sessions

Y@ D w &

Session path: C:\Jsers\david. tucker\Desktopljettatdi_southboston 2011-04-25 14-26-22.ibt -
) daviducker 4 || Name ‘ Type Ver.. Session Name Session Descriptio ‘
] ﬁ?ﬁzﬁlf -~ 4 irsdk 0.8.zip -
5 | pdob -~ 4 irsdk1.0zip
H- | .pagt - 1 MES ATLAS
- ) piscc - J. notes i
i |, thumbnails & - OpenOffice.org 3.3 (en-US) Installation Files
- 7] Contacts - | sdkdoc
- jg Desktop - . telem examples do not distribute =
- ﬂ, Duwnl.uads P headata
j ; E:\;:rltes [ | irsdk_session 2011-04-25 14-54-38.ibt Session irsdk_sessio.. Test
£ | My Documen - (- | jettatdi_southboston 2011-04-25 14-26-22.ibt Session jettatdi_sout... Test =
R T e [ [ ] 3
77‘.-—; i-ﬂ
ﬁ Ver.. Session Mame Session Description Start Laps Lap timg
=52 Layerl
ﬁ jettatdi_southboston 2011-04-2514-26-22.ibt  Sessifin jettatdi_sout... Test 00:00:5... 16 00:23.5.
%3 Layer 2 (Active)
_é Jettatdi_southboston 2011-04-2514-26-22.ibt on Jettatdi_sout... Test 00:00:5... 16 00:23.5.

|

1 |

[7] Load function constants

&

[¥]Load associate sessions Edit Details

Next, open the Layers tab and select show overlays. Finally you need to check the box next to the
layer in order to tell ATLAS what layers to compare.

-

Properties - [Shocks]

| Parameters I Ewvents | Layers | Display I Wcrkbmkl

Mo | Laper

| Session

| Timebasze | Offzet | Colow

2

1 ma Full 2011-05: Test
wama full 2011-05-1 Test

o.oo00

0.00000

Fastest lap
Fasztest lap

Active Layer:

[mx5 cup_okayama full ]

Link ta Active Layer
@ Duration and posttion
(7 Posttion only
() et linked
Timebase Events ]

Live mode onhy Show overays

Live Mode
[ Stay Live

Colours: | Use one colour per layer v]

Mode:
Auto fit laps
[] Apply to all displays on layer

Lok |

Cancel | [ Aoply |[ Hep |
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Now when you view your graph, you will notice that you can see two different sets of line. There is
also a new variable called Toif£ that shows you the difference in time between layer one and layer two.

A TS Epiess - IHnelngia i - [Wavefonn? - s sesslun 200 U200 - G0-2a 10| _J _J J
N Ele Session Yiew Tools MWindow Help -3 %
== = o M0 R kB g B Ay G R W | fid s Es | ME |20 nal B B R T

L1:irsdk_sessio

L = I
T-0111.883 |~ | e | ISR Ry
0.00000 [s] 2- 0315 857 4.’“‘."“‘%&'_

irsdk_se. .. irsdk_se... g5 € 0 m
|

1 1 L
1000 2000 3000

Standard | Traction Circle J Ride Hewght] Tyre Temps J RPM Scatter J Force Feedhackl
Loaded workbook iftacing.whlk. L1:offline

This is very useful in measuring time gained or lost from lap to lap.

If you would like to build a Circuit Map from the data, click on 'Tools->Circuit Definition
Editor'. Select the 'Map tab', and click on the 'parameters' button.

Mapping Parameters @
Select Parameters used to map cincuit:
Diztance: LapDist E]
Speed: Speed KPH |_|

Lateral G:  Lathcceld (]

Correlation: []

Ok || Cancel || Help |

Set the Distance parameter to be LapbDistance, the Speed parameter to the function F_speedkpr and
the Lateral G parameter to the function F_rataccelg, then hit OK. Now go back to the Map tab and
adjust the offset until the track looks correct. In addition you may need to select the invert button to
give the map the correct orientation.

[ 4 | nk//r L 4
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Circuit Definition - [okayama full]

General | Map Segments | Sections
Circuit Data
Session: | Test - |

Generation Settings

Gan:  p9g z

e {0.02 =

Shape

@ Circle

Figure of sight

| Invert

Open

ok.aparna full © m!

Lp ;- iF acing

ama full 201

| DOpen...

Save | | Save bz | [

Cloze l | Help |

Once your map looks correct, go to the segments tab to define the straights and corners. Defining the
straights and corners will let you navigate from corner to corner in the data.

(558

ama full 201

Circuit Definition - [okayarna full]
General | Map | Seaments | Sections

Name Distance Type i
Start-1 0 Main Straight
1 200 Comer
12 351 Straight
2 421 Comer
23 592  Straight
3 1084 Comer E
4 1245 Straight
4 2008 Comer
45 2058 Straight
5 2148 Comer
56 2225 Straight
6 2285 Comer
67 2389 Straight
7 2650 Comer
78 2721 Straight
H 2771 Comer -

| Auto Segment... | Use as Add

| Auto Name | Straig Delete

DOper...

Save

| | Save s | |

LCloze Help

A 1]//4
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Finally, if you want to edit your own math functions, select ' Tools->Function->Edit"' t0 bring up the

Function Editor Dialog.
When saving your functions be sure to put them in the [My Documents]\McLaren Electronic
Systems\ATLAS 9\Funclib folder, or they will not be visible in the Parameters list.

Also be sure to specify a Name and Format string and a proper Display min/max value before saving
the function.

@ Function Editor E@
Eile Edit Help

DEeEd &S = 4
D efault Properties

MName: F_Steeringw'h  Description: Compute FFEB force output from SteenngtwheelTorque

%

Unitz: % Format; Qo0 +  Digplay min: -1.00 Digplay max; 1.00
Calculation Mode Function Mode
@ Each Sample Paint ILeading Edge -
) Frequency of parameter with highest zample rate [ Interpolate between samples
_! Fized Frequency | 100 Join Gapz around MIJLL

[ Aways calculate over whole session

Function definition: Filter Layer: [m:-:E cup_okayama full 200 -

# iR acing FFB in game setting */ -
ilFFEB = 8;

# Enable to clip output fram 0-1 =4
showPetForce =0

m

norminalF orce = sqrit{1.0 - expl-pow( [$SteernngwheelTorque * iFFB * 0.01 4 1.71.2]]);
ifshowPetFaorce] return[ abzihominalForce)) elze f#S5teenngtwheel Torque > 0] retum{nominalForce] el

-

Parameters | Compilation Output
Groups: Available [tems:
Groups | | Parameters Description Un... it
iHaci.ng ) = | abszlx] Ahbzolute value of x
Session Details acos(x] Arc cozing of ¥ [radians)
Functions . . )
azinx] Arc zing of x [radians]
Al Groups atan(x) Arc tangent of x [radianz]
= ? :
atan2[x.y] Arc tangent of %/y [radians)
Filter: BiLinearlnterpa...  Bi-inearly mterpolated wvalue
BitOfwfordip k) True if in param p, bit b iz set i

\
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